
Forms

I n t h i s c h a p t e r y o u w i l l l e a r n :
• How to Modify a form’s labels and Text Box controls

• How to Use List Box and Combo Box controls

• How to Place a calculated control on a form

• How to Place a Check Box control on a form

• How to Use special Combo Box controls

• How to Place an Option Button control on a form

• How to Create a form with a subform

• How to Print a form

• How to Document a form

Case: What SUP, Inc.

Nathan and Meagan are now ready to expand the use of forms in their rapidly
expanding database. They recall that forms have a variety of purposes. Previ-
ously they created a form to capture additional information about their products.
Now Kyle suggests they create a form with more features.

Kyle tells them that they can add functionality to forms with such features as
calculated controls, check boxes, option buttons, list boxes, combo boxes, and
subforms.

‘‘Once again this sounds like more than we need!’’ Nathan exclaims.
‘‘Don’t panic,’’ says Meagan. ‘‘Kyle seems to know just how much of this

stuff we can take. Give him a chance.’’
Kyle thanks Meagan for her confidence and convinces them that, in the long

run, using forms in their database will allow them to use their product database
more efficiently and to improve the integrity of the data input.

Labels and Text Box controls

In this section you will become familiar with the steps necessary to modify a
form’s labels and text box controls. Forms are often created using the Forms
Wizard, but once created they often need to be customized. Customization
includes moving controls and labels and resizing the form itself.
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Kyle suggests that you modify a form that was previously created using the
Forms Wizard. This would yield a form more like the one Nathan used to keep
on each supplier.

‘‘That would be helpful,’’ Nathan comments. ‘‘I feel more comfortable using
an electronic version of a form I’ve already worked with on paper.’’

Kyle explains that the purpose of this exercise is to become familiar with the
process for moving controls around a form.

To modify the Suppliers form:

1 Start Access.

2 Click the File tab and then click Open.

3 Navigate the Open window to the location of this text’s student files.
(The location would be the CD provided with text or from your com-
puter lab’s server.)

4 Double-click ch12-01, which should be located in a Ch 12 folder.
(This is a modified version of the completed What SUP Inventory file
from previous chapters. Do not use the file you completed in the pre-
vious chapter.)

5 Click the File tab and then click Save Database As.

6 Navigate the Save As window to the location you wish to save this
file and type Ch12-01_student_name in the File Name: text box
(replacing student_name with your name).

7 Click Save.

8 Double-click Supplier to view the form shown in Figure 12.1.

9 Click View and then click Design View.

10 Click and hold in the lower right corner of the Supplier form to reveal
the dragging tool, then move the window down and to the right to
reveal the Form Footer. The process will expand the size of the
Form Design view window so that you can manipulate all the objects
on the form.

Figure 12.1
Existing Supplier Form
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11 Click the top portion of the Form Footer and drag down to expand the
size of the form and make space available to move controls around, as
shown in Figure 12.2.

12 Click in the upper left-hand corner of the First Purchase label and
drag the label to move it. Next click the upper left-hand corner of the
First Purchase text box and drag it to move the view. Position the
label and text box as shown in Figure 12.3.

13 Click in the ST label and change this label to read State. Select this
label, click the Home tab, and then click the Center tool in the Text
Formatting group.

14 Click the right center handle on the State label and drag it to the left
to resize the label.

15 Click the top of the State label and then drag it to reposition it on the
form.

16 Resize, reposition, and center the StateOrProvince text box using
the same process used for the State label until your screen looks like
Figure 12.4.

17 Click View to view the form in Form View. The form should look
like Figure 12.5.

18 Click File, Save As, Save Object As, and Save As to save this new
object.

Figure 12.3
Separating a Label

from a Control

Figure 12.2
Increasing the Size of

the Form
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‘‘Modifying a form’s controls was fairly intuitive,’’ Meagan comments,
‘‘although it was a bit difficult to line up labels and text boxes so they were
properly aligned.’’

Kyle agrees and now suggests that you and Nathan explore the use of form
controls—such as list and combo boxes—to help simplify the data entry process
and improve the integrity of information captured in your database. He will also
show you how to specify locations of controls more precisely.

List Box and Combo Box Controls

The form you just modified included a series of text box controls containing
information such as a supplier’s name, address, and so on. These text boxes are
referred to as a type of form control. You use text boxes on a form or report to
display data from a record source. This type of text box is called a bound text
box because it’s bound to data in a field. In this case, for example, the text box

19 Type Supplier A as the new form name and then click OK.

20 Click the Home tab and then close the form.

Figure 12.5
Form View of Modified
Form

Figure 12.4
Modified Supplier Form
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control Supplier Name was bound to the field Supplier Name in the Supplier
table. Text boxes can also be unbound. For example, you can create an
unbound text box to display the results of a calculation or to accept input from
a user. Data in an unbound text box isn’t stored anywhere, but we will discuss
unbound text boxes later.

Kyle explains that it’s often quicker and easier to select a value from a list
than to remember a value when using a form to enter new information, such as
a new supplier. A list of choices also helps to ensure that the value entered in a
field is correct. If you have enough room on your form to display the list at all
times, you might want to use a list box. If you want to create a control that
displays a list but requires less room then you would use a combo box, which
provides the combined functionality of a list box and a text box.

‘‘Which should we use, and when?’’ asks Meagan.
‘‘Well, let’s try something simple first, like modifying an existing text box

control in our supplier form to a list box,’’ answers Kyle.

List Box Control
Kyle explains that modifying a control on a form simply requires changing the
form control (from text to list) and creating the list of choices.

‘‘Let’s modify the Country text box control on our previously created
supplier form to a list box control,’’ suggests Kyle. ‘‘We will also add a new
supplier from Canada.’’

To change the Country text box control to a list box control
and add a new supplier:

1 Double-click the Supplier A form.

2 Click View and then click Design View. Move the First Purchase
label and field to a location under the Fax label and field.

3 Right-click the Country text box control; then click Change To and
click List Box, as shown in Figure 12.6.

4 Right-click the Country list box control; then click Properties.

Figure 12.6
Shortcut Menu to

Transform a Text Box
Control to a List

Box Control

312 Part 2 Access for Accounting

Copyright 2014 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). Editorial review has 
deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



5 In the Property Sheet for List Box: Country, click the Data tab, click
Value List in the Row Source Type section, and then type USA;
CAN; UK in the Row Source (see Figure 12.7).

6 Close the Property Sheet window. The form should now look like
Figure 12.8.

7 Click View and then click Form View.

8 Enter a new supplier by clicking on the New (blank) record button
located at the bottom of the form and then typing the information pro-
vided in Figure 12.9. Observe that, in order to specify the country for
this new supplier, all you had to do was click CAN.

9 Click File, Save As, Save Object As, and Save As to save this new
object.

10 Type Supplier B as the name of the new form and then click OK.

11 Click the Home tab and then close the form.

Figure 12.8
Modified Form with List
Box Control for Country

Figure 12.7
Modifying the Properties of
the Country Control
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You have now modified an existing form to include a list box control. Now
Kyle suggests you look at the combo box control as an alternative.

Combo box Control
Once again, a combo box control is a control that is used on a form and pro-
vides the combined functionality of a list box and a text box. In this situation,
someone entering a new supplier using the Supplier form can either type new
information into a combo box control (like a text box control) or select from an
existing list of information (like a list box control) without taking up much
space.

Kyle suggests you try out a combo box control by changing the State text
box control to a combo box control that lists the four most common states in
which your suppliers reside.

To change the State text box control to a combo box
control:

1 Double-click Supplier B.

2 Click View and then click Design View.

3 Right-click the State Or Province text box control; then click Change
To and click Combo Box.

4 Increase the size of the StateOrProvince combo box control and
related label slightly.

5 Right-click the State Or Province combo box control and then click
Properties.

6 Click the Data tab.

7 Click Value List from the Row Source Type drop-down list.

8 Type CA;NY;MA;NJ in the Row Source section. The Properties
Sheet should look like Figure 12.10.

9 Close the Properties window.

Figure 12.9
New Record
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‘‘What if I wanted to move the State control to the left and the Zip control to
the right. Would that change the order in which I tab through the controls?’’
Nathan asks.

‘‘Actually no. Moving controls doesn’t change tab order. However, there is a
way to do both,’’ Kyle explains. ‘‘Let me show you.’’

10 Click View and then click Form View.

11 Click the Next Record arrow in the lower left-hand corner of the
Supplier form until you see record 7 supplier 8 Jimmy Lewis.

12 Click the drop-down arrow in the State control. Your screen should
look like Figure 12.11. Note that the combo box shows four options
(those that you just set up for that control). The state indicated, how-
ever, is BC, which is acceptable even though it is not one of the
options you set up.

To move controls and change the tab order:

1 Click View and then click Design View. Move the Zip and State
labels and fields so that State is next to City and is followed on the

Figure 12.11
State Combo Box Control

Figure 12.10
Property Sheet for the State
Combo Box Control
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right by Zip, and then make the Zip label and field smaller. Switch
back to the Form view and click in the ID field. Then press the [Tab]
key several times to work your way through the supplier form. Note
that from the City field, tab moves you to the Zip field and then back
to the State field. Switch back to the Design View.

2 Right-click anywhere in the Supplier B form and then click Tab
Order.

3 Click the far left-hand side of the State Or Province control and move it
up. Then move other fields so that your screen looks like Figure 12.12.

4 Click OK to save the changed tab order.

5 Click View and then click Form View.

6 Click the New (blank) record arrow.

7 Type 9 as the ID and then press [Tab] to move to the Supplier field.

8 Type Rigid as the supplier name and then press [Tab] to move to the
next field.

9 Type Rex Tander as the supplier contact and then press [Tab] to
move to the next field.

10 Type Sales Associate as the supplier title and then press [Tab] to
move to the next field.

11 Type 253 Cabrillo Blvd. as the supplier address and then press [Tab]
to move to the next field.

Figure 12.12
Changing the Tab Order
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You have now created a combo box control on a form to ease the creation of
new supplier records, and you have found that it acts like both a text box and
list box control. Now it is time to experiment with other features, such as calcu-
lated controls.

Calculated Controls

A calculated control uses an expression as its source of data. An expression is
any combination of mathematical or logical operators, constants, functions,
names of fields, controls, and properties that evaluate to a single value. For
example, an expression can use data from a field in an underlying table, from a
query of a form or report, or from another control on the form or report.

Bound controls obtain their data from fields in a table, whereas unbound con-
trols don’t have any particular data source other than an expression. Kyle
explains that, in order to calculate the total cost invested in any particular prod-
uct, Nathan would have to multiply the units on hand times the unit cost. He
demonstrates that both the units on hand and the unit cost are already on the
product form as bound controls Quantity and UnitPrice. However, creating a
control on the form that calculates the total cost will require that Nathan create
an unbound control (referred to in this case as a calculated control) to calculate
the product of Quantity times Unit Price.

12 Type Santa Barbara as the supplier city and then press [Tab] to
move to the next field. (Note that this moves you to the State field
since you changed the tab order.)

13 Select CA as the supplier state and then press [Tab] to move to the
next field.

14 Type 93101 as the supplier zip and then press [Tab] to move to the
next field.

15 Select USA as the supplier country and then press [Tab] to move to
the next field.

16 Type 8055554127 as the supplier phone and then press [Tab] to move
to the next field.

17 Type 8055554128 as the supplier fax and then press [Tab] to move to
the next field.

18 Type 10/1/2015 as the supplier first purchase date and then press
[Tab]. That last tab should have entered the new supplier and brought
you to a new supplier form.

19 Click File, Save As, Save Object As, and Save As to save this new
object.

20 Type Supplier C as the form name, click OK, click the Home tab,
and then close the form.
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‘‘Bound, unbound, I’m bound up just thinking about these,’’ Meagan com-
plains. ‘‘Do we really have to understand this to create a useful form?’’

‘‘Well,’’ responds Kyle, ‘‘I think you’ll find them useful in many forms you
might create and they are really not that difficult. Here, let me show you.’’

To add a control to calculate the total cost in inventory of
each item:

1 Double-click the Products form.

2 Click View and then click Design View.

3 Click the Text Box control from the Controls group on the Design tab
of the Ribbon, as shown in Figure 12.13.

4 Place the cursor in the product form under the Picture label click and
then drag to the right and down while holding the left mouse button
down, then release the left mouse button down to create a new text
box control as shown in Figure 12.14.

5 Right-click the Unit Cost label control; then click Properties.

Figure 12.14
Adding a New Text
Box Control to the

Products Form

Figure 12.13
Form Design Tools on the

Ribbon
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6 Click the All tab to view format properties for the Unit Price label
control. A portion of the Format Properties window is shown in
Figure 12.15.

7 Note the width, height, and left properties. (Width defines how wide
the label should be, height defines how tall the label should be and
the left defines how far from the margin the label should be.)

8 Click the newly created text box control and then click the newly cre-
ated text box label control; note how the Property Sheet now reflects
properties for the new text box label. (Be sure you select the label, not
the text box.)

9 Click the All tab if it is not already selected.

10 Type Total as the name property of the new text box label.

11 Type Total as the caption property of the Total text box label.

12 Type 1.2083 as the width property.

13 Type .2083 as the height property.

14 Type 3.5 as the top property.

15 Type 0.0417 as the left property. Your Properties window should look
like Figure 12.16.

Figure 12.16
A Portion of the Properties
Window of the Total Text
Box

Figure 12.15
A Portion of the Properties
Window for the Unit Cost
Label Control
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16 Click the Unit Cost text box. A portion of the Format Properties win-
dow for the unit price control is shown in Figure 12.17.

17 Note the width, height, and left properties.

18 Click the Unbound text box control and observe that the Property
Sheet now reflects properties for this text box control.

19 Type Total Amount in the Name box.

20 Type ¼[Quantity]*[UnitCost] in the Control Source box.

21 Select Currency as the format property.

22 Type 1.4583 as the width property.

23 Type 0.2083 as the height property.

24 Type 3.7917 as the top property.

25 Type 0.0417 as the left property. Your Properties window should now
look like Figure 12.18.

26 Close the Properties window.

Figure 12.18
A Portion of the Properties

Window for the Total
Amount Text Box

Figure 12.17
A Portion of the Properties

Window for the Unit
Price Control
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You’ve now seen the process for creating a calculated control. Both Nathan
and Meagan seem more comfortable with the terms and processes and are
anxious to know if there are any other useful controls available in Access.

Check Box Control

When implemented on a form, the check box control gives the user the choice
of activating all, none, or some of the check boxes. In each case, a check box
control returns a Yes value if checked and returns a No value if unchecked.
This control, like other controls, can be bound or unbound. To create a bound
check box control, you must be working in a form or report that is bound to a
record source.

Kyle asks Meagan if there are any situations in which she thinks a control
like this might be helpful on a form. She suggests that, in the Buyers table, it
would be nice to know who specializes in what category of product. For

27 Click View and then click Form View. The format seems a bit out of
place. Move controls around the form (in Design View) so that your
new form looks like Figure 12.19.

T r o u b l e ? If you did not type the expression exactly as speci-
fied, then you may end up with the message ‘‘#Name?’’ in the text
box where you expected to see the $1,400.00 total cost. Reexamine
the Control Source section of the Properties window for the total text
box to verify that you’ve typed the expression correctly.

28 Click File, Save As, Save Object As, and Save As to save this new
object.

29 Type Products A as the new form name and then click OK.

30 Click the Home tab and then close the form.

Figure 12.19
New Product Form with
a Total Control
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instance, some buyers specialize in only one category, like Flatwater boards,
while others specialize in several categories.

‘‘Would a check box control be appropriate here?’’ she asks.
‘‘Yes,’’ you respond. ‘‘But if you want to store this information for later use,

doesn’t it have to be a bound control? And if so, don’t we have to create some
new fields in the Buyers table?’’

Kyle compliments you on your comprehension of this topic. He agrees that
this is a situation where a bound control is appropriate, but he points out that the
buyer table fields must first be created and set up in a data type called Yes/No.

Now that the Buyers table includes the field for data storage, you offer to
modify the Buyers form to include check boxes for quick data entry.

‘‘How do I create check boxes on the form?’’ you ask.
‘‘All you’ll need to do is add the fields you just created in the Buyers table

to the Buyers form. Because they are of the data type Yes/No, they will auto-
matically be added to the form as a check box control,’’ Kyle responds.

To create additional fields in the Buyers table:

1 Right-click Buyers Table and then click Design View.

2 Add six new fields to the table and specify each as a Yes/No data type,
as shown in Figure 12.20.

3 Close the Buyers Table. Click Yes to save changes.

To create a check box control bound to a field:

1 Right-click the Buyers form and then click Design View.

2 Resize and move the Buyers form and Field list windows so that your
screen looks like Figure 12.21.

3 Click Add Existing Fields from the Tools group of the Design tab on
the Ribbon.

4 Click and drag all six fields you just created, one at a time, to the
Buyers form (see Figure 12.22).

Figure 12.20
Modifying the Buyers

Table
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5 Click View and then click Form View.

6 Update each record from the Buyers form to indicate in what category
each buyer specializes by clicking in the check box to place a check
mark in the box. (Note: Clicking a second time will remove the check
mark.) Buyer 601 specializes in Flatwater, Inflatable, and Race
SUPs. After updating Buyer ID 601, your Buyers form should look
like Figure 12.23.

Figure 12.23
Buyer ID 1 Updated
Record

Figure 12.21
Modifying the Buyers Form

Figure 12.22
Adding Existing Fields
to a Form
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‘‘I like using these new controls,’’ comments Meagan. ‘‘But I still have a
question on the combo box controls we did before. Is there a way to give our
database users a choice of options that change as our company grows?’’

‘‘There sure is,’’ Kyle responds. ‘‘I’ll introduce you to special combo box
controls next.’’

Special Combo Box Control

An additional possible use of a combo box control would be to give the user a
choice of options that change as a function of other changes that may occur in
the database. For instance, let’s say you want to give the user the option of
selecting a specific supplier for each product but that you want the list to be
dynamic, not static. In other words, you’d like the user’s available choices to be
limited to those suppliers currently in your Supplier table. Thus, when you add
a supplier the list expands and, of course, when you delete a supplier the list
contracts.

‘‘That would be perfect for our product form,’’ you suggest. ‘‘I can see using
that form to add new products and then choosing from a list of existing suppli-
ers to provide the product.’’

‘‘How is that different from what we just did with the state and country
combo boxes?’’ Meagan asks.

‘‘In those situations,’’ Kyle explains, ‘‘we provided a list of choices for the
combo list. However, the user could type in a different state or country from
those we listed. Plus, the list never changes unless we physically rewrite the list
in the control.’’

‘‘So where do we create the list?’’ you ask.
‘‘Actually, we just point the control to the Supplier table. As names are

added to or removed from that table, the combo box control changes,’’ says
Kyle. ‘‘Nathan, let me show you how it is done.’’

Kyle explains that Nathan’s goal will be to modify the existing Product form
so that the Supplier text box control is transformed to a combo box control with
a list containing the supplier ID numbers and names that exist in the Supplier
table. This will require that the existing relationship between the Product table
and the Supplier table be temporarily eliminated (since it currently enforces ref-
erential integrity) and that the data type of the SupplierID fields be changed.

7 Continue your update. Buyer 602 specializes in Inflatable, Race, Surf,
and River SUPs. Buyer 603 specializes in Flatwater SUPs and
Paddles. Buyer 604 specializes in Surf SUPs only.

8 Click File, Save As, Save Object As, and Save As to save this new
object.

9 Type Buyers A as the name of the new form and then click OK to
save the form.

10 Click the Home tab and then close the form.
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To modify the Product table and change the Supplier ID
field’s data type:

1 Click Relationships from the Relationships group on the Database
Tools tab of the Ribbon.

2 Resize the windows so that your screen looks like Figure 12.24.

3 Right-click the relationship between the Product table and the Supplier
table; click Delete and then click Yes in the dialog box that appears in
order to confirm your deletion.

4 Close the Relationships window and click Yes if asked to save
changes.

5 Right-click Product Table and then click Design View.

6 Click Lookup Wizard from the drop-down list of data types for the
Supplier ID field, as shown in Figure 12.25.

Figure 12.25
Changing Data Type to
Lookup Wizard

Figure 12.24
Existing Relationships
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7 Click on the first option button (I want the lookup field to get the val-
ues from another table or query.) and then click Next.

8 Click Table: Supplier Table from the next Lookup Wizard dialog
box; then click Next.

9 Double-click Supplier ID and Supplier Name in the list of Available
Fields in order to move them to the list of Selected Fields, as shown
in Figure 12.26.

10 Click Next; then click Supplier Name from the drop-down list in box
1 as the field to sort on.

11 Leave Ascending as the sort order, and then click Next.

12 Uncheck the Hide key column check box and resize the column
widths if necessary so that your screen looks like Figure 12.27.

13 Click Next.

14 Click Next again to keep the Supplier ID as the field being stored.

Figure 12.27
Organizing Columns

in the Lookup Column

Figure 12.26
Identifying Fields to be
Included in the Lookup

Column
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Kyle explains that now Nathan can modify the Products form to include the
new and revised Supplier ID field as a combo box control. But first, he cau-
tions, Nathan will have to remove the old Supplier ID text box control from the
form.

15 Click Finish to keep Supplier ID as the label for your column.

16 Click Yes to save the table.

17 Close the modified Product table.

18 Once again, click Relationships from the Relationships group on the
Database Tools tab of the Ribbon.

19 Double-click the relationship between the Product table and the
Supplier table.

20 Click in the Enforce Referential Integrity check box and then click
OK.

21 Close the Relationships window.

To create a combo box control linked to the Supplier table:

1 Right-click Products A and then click Design View.

2 Click the existing Supplier ID text box control; then press the
[Delete] key to delete both the SupplierID label and text box.

3 Click Add Existing Fields from the Tools group of the Design tab on
the Ribbon.

4 Click and drag the Supplier ID field to the Products A form, as
shown in Figure 12.28.

Figure 12.28
Adding the Newly Modified
Supplier ID Field to the
Products A Form
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5 Close the Field List window.

6 Click View and then click Form View.

7 Note that the Supplier ID of record 1 in the Products A form is still
specified as 1. Click on the drop-down list arrow of the Supplier
ID combo box control to see the options available, as shown in
Figure 12.29.

8 Click File, Save As, Save Object As, and Save As to save this new
object.

9 Type Products B as the name of the new form.

10 Go to record 7, the Sleeping One, and change the Supplier ID from 5
to 6 (Fanatic.) as shown in Figure 12.30.

11 Now change the Supplier ID of the same record by typing 4 in the
combo box control and then moving to the next record.

12 An alert dialog box should appear, indicating that this choice is not
acceptable because a related record is required in the Supplier table.
Since there is no supplier with an ID of 4, the system rejects your
change. Click OK.

Figure 12.30
Modifying an Existing

Record

Figure 12.29
Modified Product Form

with Lookup Capabilities
for SupplierID
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In addition to form controls, subforms are helpful in situations where a one-
to-many relationship exists. Kyle suggests that understanding subforms may
actually help resolve some of their previously expressed inventory tracking con-
cerns.

Subforms

Subforms are simply forms within forms. Subforms require that information in
one form have a one-to-many relationship with the information in another form.
Kyle explains that users often like to see specific information on one form that
has some common characteristic.

‘‘For instance,’’ says Kyle. ‘‘You have already established a relationship
between the categories of your products and the products themselves, so we
have a one-to-many relationship. One category, for example, includes many
products.’’

‘‘So we could create a form showing all the products we have that fall within
any of our categories?’’ asks Meagan.

‘‘That’s it!’’ Kyle responds. ‘‘Let’s have you create this form within a form
using the Forms Wizard.’’

13 Change the Supplier ID of record 7 back to 5.

14 Close the form.

To create a form and subform of categories and products:

1 Click Forms Wizard, from the Forms group of the Create tab.

2 Select Table: Category Table from the list of Tables/Queries.

3 Click Category Name from the list of Available Fields; then click the
> button to move Category Name from the list of Available Fields to
the list of Selected Fields.

4 Select Table: Product Table from the list of Tables/Queries.

5 Click ProductName from the list of Available Fields and then click
the > button.

6 Click Quantity from the list of Available Fields and then click the >

button.

7 Double-click UnitCost from the list of Available Fields (note how this
accomplishes the same task of moving the field from Available Fields
to Selected Fields). Your window should now look like Figure 12.31.

8 Click the Next button.

9 Click by Category Table.
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10 Click the Form with subform(s) option button. Your window should
look like Figure 12.32.

11 Click Next.

12 Click the Data sheet layout option button and then click Next.

13 Type Products by Category as the form title and Products Subform
as the subform title.

14 Click Finish to save the new forms. Your window should look like
Figure 12.33.

15 Observe that not all products, quantities, or unit costs may be visible.
Click View and then Layout View.

Figure 12.31
Using the Forms Wizard

Figure 12.32
Creating Forms with

Subforms
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This newly created form and subform is ideal for viewing products by cate-
gories. Nathan is impressed.

16 Modify the width of each column by double-clicking between column
titles until your window looks like Figure 12.34.

17 Click View and then Design View. Resize the Products Subform con-
trol to make it smaller and then click View and then Form View.

18 Navigate the newly created form by clicking on the category record
navigator at the bottom of the form until you get to the Surf category.
The Surf category should look like Figure 12.35.

19 Click Save on the Quick Access toolbar.

20 Keep this form open for printing.

Figure 12.34
Changing Column Widths
in a Form

Figure 12.33
Newly Created Products
by Category Form and
Subform
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Printing a Form

All that is left is to print a form. Kyle remarks that printing a form is much like
printing a table or query, as you did in previous chapters. In this case he just
needs you to print the first record (Watches).

To print a form:

1 With record 4 showing on the Products by Category form you just cre-
ated; click the File tab and then click Print.

2 Click Print again, and then choose the Selected Record(s) option in
the Print Range section of the Print window and then click OK. The
printed form should look like Figure 12.36.

3 Close and save the Products by Category form.

Figure 12.36
Printed Products

by Category Form
for Surf SUPs

Figure 12.35
Completed Products by

Category Form
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Documenting a Form

Kyle suggests that you document all changes made to a form so that you can
verify the underlying attributes that were changed in the course of creating or
modifying the form. In particular, he suggests you examine and print the data
properties that were changed when you converted a text box to a combo box
for the StateOrProvince field in the supplier form.

To view and print the changes made in the State Or Prov-
ince field in the supplier form:

1 Double-click Supplier C form.

2 Click Database Documenter in the Analyze group of the Database
Tools tab on the Ribbon.

3 Click the Forms tab in the Documenter window.

4 Click in the check box next to Supplier C (you may have to scroll
down the window to find it).

5 Click Options.

6 Uncheck all check boxes listed under the Include for Form section
title.

7 Click the Names and Properties option button under the Include for
Sections and Controls section title. Your screen should look like
Figure 12.37.

8 Click the Properties button.

9 Deselect all Print Categories other than Data Properties, as shown in
Figure 12.38.

10 Click OK in the Property Categories window.

Figure 12.37
Selecting Print Form
Definitions
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End Note

In this chapter you have learned how to modify a form’s labels and text box
controls, how to use list box, combo box, calculated, and check box controls,
how to create a form with a subform, and how to print document a form. Feel-
ing fairly confident, you’re ready to finish up with variations on report creation.

11 Click OK in the Print Form Definition window.

12 Click OK in the Documenter window.

13 Click Print and then click OK. Page 2 of the printout should refer to
the combo box control established for the StateOrProvince field, as
shown in Figure 12.39.

14 Close the Print Preview window and then close all windows.

Figure 12.39
Part of the Documenter for

the Supplier C Form

Figure 12.38
Selecting Print Categories
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Chapter 12 Questions

1 What view of a form is used to edit an existing form?

2 What is the difference between bound and unbound controls?

3 Why are text box controls used on a form?

4 Why are list box controls used on a form?

5 Why are combo box controls used on a form?

6 Why are calculated controls used on a form?

7 Why are check box controls used on a form?

8 When is the Lookup Wizard used?

9 Why must an existing relationship be deleted before modifying a field’s
data type?

10 What type of relationship must exist if a subform is used on a form?

Chapter 12 Assignments

1 Using the Ch12-02 file, modify the Buyers form for What SUP so that it
looks like Figure 12.40. Save this form as Ch 12 Assignment 1, and print
record 1 using this form.

2 Modify the Products form by changing the Category ID text box control
to a list box control that lists the choices as A, B, C, D, E, or F. Save
the form as Ch 12 Assignment 2. Print the newly created form for Prod-
uct ID 101.

3 Modify the Product form (not the Ch 12 Assignment 2 form you just cre-
ated) by changing the Category ID text box control to a combo box con-
trol that lists choices of A, B, C, D, E, or F. Save the form as Ch 12
Assignment 3. Print the newly created form for Product ID 101.

12

Figure 12.40
New Buyers Form
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4 Salespeople earn a 10 percent commission on the price of each sale. Cre-
ate a new unbound calculated control to compute the possible commis-
sion on each product. Modify the Products form (not the Ch 12
Assignment 3 form you just created) by adding a calculated control
called Commission. (The expression created should multiply the unit
price by .10.) Format the control in a currency format. Save the form as
Ch 12 Assignment 4. Print record 7 using this form.

5 Add a new field (Taxable) to the Product Table. Make the field a Yes/
No data type. Add this new field to the Products form (not the Ch 12
Assignment 4 form you just created) to the right of the Reorder Level
control. Make record 6 (Glide GS) taxable. Save the form as Ch 12
Assignment 5. Print record 6 using this form.

6 Modify the Products form (not the Ch 12 Assignment 5 form you just
created) by changing the Category ID text box control to a special combo
box control, listing the choices of CategoryID and CategoryName from
the Category table. (Hint: Be sure to first remove the relationship
between the Product and Category tables and then, after you’ve created
the combo box control, to reestablish the relationship and related referen-
tial integrity. Save the form as Ch 12 Assignment 6. Print the newly cre-
ated form for Product ID 101.

7 For each buyer name, create a form (using the Forms Wizard) that con-
tains the product name, quantity, and unit price of each product that the
buyer is responsible for. Use the subform option with a datasheet layout.
Save the form as Ch 12 Assignment 7 and the subform as Ch 12 Assign-
ment 7 Subform. Format the subform so that columns fit in the form cre-
ated. Print record 4 (Buyer ¼ Fortier) using this form.

Chapter 12 Case Problem 1:

KELLY’S BOUTIQUE
Note: You must have completed Case 1 in the previous chapter in order to con-
tinue working on this case.

In the last chapter you added and modified some queries for Kelly’s
Boutique. She would now like you to create some new forms. Make the follow-
ing changes for Kelly using the ch11-03_student_name file you created in
Chapter 11. (Note: Open your ch11-03_student_name file and then save it as
ch12-03_student_name before making the indicated changes.)

a. Create a form to look like Figure 12.41. Save the form as Ch 12 Kelly
Case a. Print record Hop on Pop.

b. Create a list box control using the form created in part a. This control
should provide the user with a list of departments: Adult, Children.
Move the picture control down to make room for the list box control.
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Save the modified form as Ch 12 Kelly Case b. Print record 7 (Green
Eggs and Ham).

c. Create a combo box control using the form created in part a. This
control should provide the user with a list of departments (as in b
above) but with a combo box instead of a list box. Dept choices
should be Adult, Children, and Teen. Save the modified form as Ch
12 Kelly Case c. Print the documenter page that documents the combo
box for Dept.

d. Create a special combo box control using the Book Form. This control
should provide the user with a dynamic list of publishers based on the
publishers listed in the Publisher table. The combo box should list
publisher number and name, and referential integrity must be
enforced. Label the combo box column Publisher. Save the modified
form as Ch 12 Kelly Case d. Print the documenter page that docu-
ments the combo box for Publisher.

e. Using the Book Form, create a calculated control to compute the total
retail value of each book in stock. First add the quantity field to the
form and then add the calculated control. Format the control in cur-
rency, and label the control Total Retail Value. Save the modified
form as Ch 12 Kelly Case e. Print the record containing the book title
‘‘Angela’s Ashes’’

f. Using the Book Form, create a check box control to indicate whether
or not the text is a bestseller. Label the field and control Best Seller.
Mark the book Green Eggs and Ham as a bestseller using your new
form. Print the record that contains the book title ‘‘Green Eggs and
Ham’’ and then save the modified form as Ch 12 Kelly Case f.

g. Create a form and subform that shows all books by publisher, listing
ISBN and Book Title in datasheet layout. Then save the modified
form and subform as Ch 12 Kelly Case g and Ch 12 Kelly Case g

Figure 12.41
New Books Form
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Subform. Print the record with Arthur A. Levine Books as the pub-
lisher.

h. Make sure to keep a copy of this file for use in the next chapter.

Chapter 12 Case Problem 2:

WINE DEPOT
Note: You must have completed Case 2 in the previous chapter in order to con-
tinue working on this case.

In the last chapter you modified some queries for the Wine Depot. Now Bar-
bara would like you to help her create some new forms. Make the following
changes for Barbara using the ch11-04_student_name file you created in
Chapter 11. (Note: Open your ch11-04_student_name file and then save it as
ch12-04_student_name before making the indicated changes.)

a. Change the Type field in the Wine Products table to a short text type
with a field size of 30. Use the Forms Wizard to create a new form from
the Wine Products table and Winery Table that includes the following
fields: SKU, Cost, Price, Quantity, Size, Vintage, Type, Picture, and
Winery Name. Use a justified layout and entitle the form Wine Prod-
ucts; then modify the form to look like Figure 12.42. Save this form as
Ch 12 Wine Depot Case a. Navigate to SKU 14539 and print that
selected record only. (Hint: Be sure to set the picture properties field to
size mode ‘‘zoom’’ by right-clicking the picture object in the design
view, selecting properties, and choosing zoom as the size mode.)

b. Modify the form you created and saved in a above by changing the
Type text box to a list box control that provides a list of all wine
types: Cabernet Sauvignon, Chardonnay, Fume Blanc, Merlot, Pinot
Noir, Sauvignon Blanc, Syrah, Red Chianti, and Zinfandel. Save the
modified form as Ch 12 Wine Depot Case b. Print the record contain-
ing SKU 12895 only.

Figure 12.42
New Wine Products

Form
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c. Modify the form you created in part b by replacing the Winery Name
field with a Winery field (from the Winery Table). Then change the
Winery text box to a combo box control that provides a drop-down
list of all 21 wineries. Your new combo box should contain a value
list that you create listing each winery by number. For example: 1,2,3
etc. Save the modified form as Ch 12 Wine Depot Case c. Print the
documenter page that documents the combo box for Winery.

d. Modify the form you created in part c by deleting the Winery combo
box control and replacing it with a Winery combo box control based
on the winery and name fields in the Winery Table. The field should
use the winery and name fields of the Winery Table and then list the
winery name when requested. (Don’t forget to modify the relation-
ships window first and then to reestablish referential integrity!) Save
the modified form as Ch 12 Wine Depot Case d. Print the documenter
page that documents the new combo box for Winery.

e. Modify the form you created in part d by adding a check box control
in the lower right-hand corner of the form to indicate if this product
has been recommended by the Wine Spectator (a noted magazine of
wine-tasting professionals). Label the field and control ‘‘Wine Specta-
tor Recommended’’. (Hint: Don’t forget to create a field in the Wine
Products Table first.) Only three wines currently have that designation:
SKU 11475, 13883, and 15347. Save the modified form as Ch 12
Wine Depot Case e, and print the record containing SKU 15347 only.

f. Modify the form you created in part e by adding a calculated control
below the Winery Number to compute the total cost in inventory of
each product (cost times quantity). Format the control in currency and
label the control Total Cost. Save the modified form as Ch 12 Wine
Depot Case f. Print the record containing SKU 11475 only.

g. Create a new form with a subform using the Winery Table and Wine
Products Table. Use the Winery Name field from the Winery Table
and the SKU and Type fields from the Wine Products table. View the
data by winery in a datasheet layout. Use the default names provided
for the form and subform. Save the modified form as Ch 12 Wine De-
pot Case g. Print the record containing the Melville winery only.

h. Make sure you keep a copy of this file for use in the next chapter.

Chapter 12 Case Problem 3:

SNICK’S BOARD SHOP
Note: You must have completed Case 3 in the previous chapter in order to con-
tinue working on this case.

In the last chapter you created some queries for the Snick’s Board Shop.
Now Caitlin would like you to help her create some forms to view information
from the database. Make the following changes for Caitlin using the
ch11-05_student_name file you created in Chapter 11. (Note: Open your
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ch11-05_student_name file and then save it as ch12-05_student_name before
making the indicated changes.)

a. Note the existing relationships between the Product, Manufacturer, and
Category tables. Now delete those relationships, and then change the
field size of ProductID to 10, ProductName to 35, ManufacturerID to
10, Style to 15, CategoryName to 25, ManfacturerName to 25, and
PhoneNumber to 15. Now reestablish the relationships you previously
deleted enforcing referential integrity. Use the Forms Wizard to create a
new form that includes the ProductID, ProductName, CategoryName,
ManufacturerName, Price, Style, Quantity, and Picture fields. View the
data by Product in a Columnar layout. Name your form Form A and
then navigate to ProductID 62-01296 and print that record only.

b. Modify the form you created and saved in (a) by changing the
CategoryName text box to a list box control that provides a list of all
Categories: Complete, Ramp, Longboards, Protective Gear, Rails, and
T-Shirts. Move the fields below CategoryName down so all are view-
able on the form. Change the title of the form to Form B in the form
header and then save the modified form as Form B. Print the record
containing 65-00335 only.

c. Create a new form containing all of the fields from the product table in
columnar layout with a title of Form C. Make the ManufacturerID a combo
box control based on the ManufacturerID field of the Manufacturer table.
Print the documenter page that documents the new combo box.

d. Add a new data type Yes/No field titled Green to the Manufacturer
table and then add a new form containing all the fields in the Manu-
facturer table in columnar format titled Form D. The new Green field
designates whether a manufacturer has qualified for the energy-saving
status granted by the state. Currently only Zero, Anti-Hero, and Gold-
coast are designated ‘‘Green’’ by the state. Place checks in the Green
fields for those three manufacturers. Print the Anti-Hero record.

e. Create a new form containing the ProductID, ProductName, Price,
Discount, and Picture fields viewed by Product in a Columnar layout
titled Form E. Delete the Picture label and move the picture control to
the right hand side of the form. Resize the ProductName and Price
fields so that your form looks like Figure 12.43:

Now add a new calculated control titled DiscountedPrice and format-
ted as currency below the Discount field to compute the discounted
price (Price less discount, if any). Print the record for ProductID
65-00358.

f. Create a new form with a subform containing the fields Category-
Name, ProductName, Price, and Style viewing the data by Category is
a Datasheet layout and title Form F. Resize the fields displayed in the
subform and then print the form for the LongBoard category.

g. Make sure you keep a copy of this file for use in the next chapter.
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Chapter 12 Case Problem 4:

ROSEY’S ROSES
Note: You must have completed Case 4 in the previous chapter in order to con-
tinue working on this case. In the last chapter, you created some queries for
Rosey’s Roses. Now the company would like you to help it create some forms
to illustrate information from the database. Make the following changes using
the ch11-06_student_name file you created in Chapter 11. (Note: Open your
ch11-06_student_name file and then save it as ch12-06_student_name before
making the indicated changes.)

a. Note the existing relationships between existing tables. Now delete
those relationships, and then change the field size of ID, Quantity,
Quote Number, Quantity Ordered, and GrowerID to integer with 0
decimal places, Cost/Unit to currency with 2 decimal places, Customer
Number to a field size of 5, Type to field size of 10, and Grower
Name and Contact to field size 40. Now reestablish the relationships
you previously deleted enforcing referential integrity. (Hint: Be sure
to change all instances of the fields you just changed.) Use the Forms
Wizard to create a new form that includes the ID, Product Description,
Type, type Description, Grower Name, Quantity, and Picture fields.
View the data in a columnar layout with no grouping. Save your form
as Form A and then navigate to ID 6 and print that record only.

b. Modify the form you created and saved in (a) by changing the Type
field text box to a list box control that provides a list of all Types:
Climber, Creeper, Shrub, and Tree. Move the fields below Type down
so all are viewable on the form. Change the title of the form to Form
B in the form header and then save the modified form as Form B.
Print the record containing product ID 10 only.

Figure 12.43
Form E as Modified
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c. Create a new form containing all of the fields from the Product table
in columnar layout with a title of Form C. Make the Grower ID a
combo box control that provides a list of all Grower IDs: 100, 200,
300, and 400. Print the documenter page that documents the new
combo box control.

d. Modify the form you created and saved in (c) by removing the exist-
ing GrowerID field combo box control and creating a new GrowerID
field special combo box control based on the GrowerID and Grower
Name fields of the Grower table. The field should use the GrowerID
and Grower Name fields of the Grower table and then just list the
Grower Name when activated. (Don’t forget to modify the relation-
ships first and then re-establish referential integrity.) Change the title
of the form to Form D and then save the modified form as Form D;
then print the documenter page that documents the new special combo
box control.

e. Add a new data type Yes/No field titled Organically Grown to the
Grower table and then create a new form containing all the fields in
the Grower table in columnar format titled Form E. Currently only
Owen Farms is designated ‘‘Organically Grown’’ by the state. Place
checks in the Organically Green field for that grower. Print the Owen
Farms Form E.

f. Create a new form with a subform containing the fields Grower
Name, product Description, Cost/Unit, and Type viewing the data by
Grower in a Datasheet layout and form title Products by Grower and
subform title Product Subform. Resize the fields displayed in the sub-
form and then print the form for the Jackson & Perkins grower.

g. Make sure you keep a copy of this file for use in the next chapter.
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